Welcome to EDAD 890: Seminar in Educational Leadership!

I. Mission - The Educational Leadership faculty at the University of South Dakota prepare innovative scholar-practitioners for the purpose of enhancing success for all learners.

“What a leader does consistently over time eventually becomes the emphasis within the organization.” - Dr. Dave Else

“Leadership is learned many times over.” - Brad Jungling

“Never be lacking in zeal.” - Dr. Bob Stouffer

"When you improve a little each day, eventually big things occur…not tomorrow, not the next day, but eventually a big gain is made. Don't look for the big, quick improvement. Seek the small improvement one day at a time. That's the only way it happens — and when it happens, it lasts." - Coach John Wooden

"It is more important to be interested than interesting." - James Hunter
“Life is not a journey to the grave with the intention of arriving safely in a pretty and well-preserved body. But rather, to skid in broadside, thoroughly used up, totally worn out, and loudly proclaiming .... WOW what a ride.” - Mark Frost

II. Catalog Description of the Course - A highly focused, and topical course. The format includes student presentations and discussions of reports based on literature, practices, problems, and research. Seminars may be conducted over electronic media such as Internet and are at the upper division or graduate levels. Enrollment is generally limited to fewer than 20 students.

III. Required Textbook - **There is no required textbook for this course, however, there is a mandatory $50 licensing fee to obtain access to Ed Leadership Sims. When you enroll in this course you must email Mr. Ken Spero at kspero@edleadershipsimsons.com. Ken will assist you with the process of sending $50 to Ed Leadership SIMS and then receiving a temporary password to the Ed Leadership SIMS. Each week you will access a simulation and then reflect on it.**

This is a three credit-hour course, so students should expect to invest around nine hours per module in the course.

III. Method of Instruction - The course will be presented over the Internet using the D2L program as provided by the University of South Dakota. Before you begin, please take the time to complete the orientation provided. This will answer many questions regarding online instruction and will also orient you to the site with helpful information. The continuing education online orientation documents can be found at the continuing education homepage, to new students, to student support, to online orientation package at [http://www.usd.edu/-/media/files/usb-online/online-orientation-guide.asmx](http://www.usd.edu/-/media/files/usb-online/online-orientation-guide.asmx). Students will access the web site at the following URL: [https://d2l.sdbor.edu](https://d2l.sdbor.edu). Each student will have a login name and password as provided by computer services at USD. Students must have an available computer with internet access and with one of the commonly used browsers. Firefox is recommended, although Internet Explorer, Safari or Chrome work as well. Students are advised to download the latest free version of one of these browsers from the internet.

Please read through the CDE Online Student Handbook document in the getting started widget on the course homepage to review the minimum technological requirements for participation in this course.

This is a three credit-hour course, so you should expect to invest around nine hours per module throughout the course.

**Course Content** - The course is developed around modules. I need to emphasize that this is not an independent study course, yet you may work ahead to any assignment or discussion post that is available. In fact, I prefer that you work ahead when you have time because I realize that you have a very busy schedule in your current role. Please read the information in the content section of each module prior to reading the textbook.

**Discussion Board** - Following the presentation of material in the course content, there will be discussion question(s) posted in the discussion board section of Desire2Learn (D2L). Each
student will be assigned to a group of peers. The first expectation is to respond to the postings of the instructor. The second expectation is to respond to the comments of at least two of your peers in your group. Due dates are provided. The responses to your fellow students need to be of a substantive nature, adding to what was said, challenging the comment with rationale or agreeing with comments and rationale. As in all communication, there is certain etiquette when discussing online. These are referred to as netiquette expectations. For example, do not use sarcasm, keep the discussion professional, and read questions and postings carefully before responding. I always advise the leaders in this course to write any discussion post or email for the third person. The first person is the person to whom you directed the discussion post or email. The second person is the person with whom the receiver may share it. The third person is your supervisor who may ultimately receive it. Do not put anything on a discussion board that you would not feel comfortable having your supervisor read. Also be cognizant that email on your work email is retrievable in the event of litigation. Basically, all written communication is now public and permanent. There is almost no case in which you can have an expectation of privacy when putting something in writing. Other tips can be found in the continuing education online orientation document.

Contact Information - Please contact me at any time if I can help you in any way. My cell phone is (641) 629-0200, and you may call or text this number at any time. My email addresses are da dejong58198@d2l.sdbor.edu and david.dejong@usd.edu. My Twitter account is @daviddejong, and I would be especially impressed if you begin to add the hashtag #YoteLeaders to your tweets. You may contact me anytime Monday - Sunday, 24 hours a day. On weekdays I will reply within 24 hours. I will not reply to emails on weekends, so if you need an immediate response you should call or text me at (641) 629-0200.

Please know that the South Dakota Board of Regents has adopted an internal emailing system through Desire2Learn (D2L). These email addresses end with @d2l.sdbor.edu. Since this is an internal emailing system you are unable send emails from your @d2l.sdbor.edu to email addresses that end in @gmail.com or @usd.edu or @k12.sd.us. If it is an issue to constantly check your @d2l.sdbor.edu account, then you should add a forwarding option within @d2l.sdbor.edu so you will be immediately notified when you receive an email.

Technical Problems - Most technical problems experienced by students can be solved through conversation with the USD computer center help desk. This office can be reached at (605) 658-6000 or by emailing helpdesk@usd.edu. The Online Orientation Guide will provide assistance regarding technology requirements.

IV. Beliefs - Reflective leaders are skilled educators whose practices and decisions draw upon the best available theory, research, and experiential wisdom. Reflective decision-making engages administrators in cycles of thought and action based on theoretical and professional knowledge. The Division of Educational Leadership is committed to preparing reflective leaders.

V. Specific Course Objectives - Upon completion of the course, student will be able to:

<table>
<thead>
<tr>
<th>Objectives/Outcomes</th>
<th>NELP Standards</th>
<th>This assignment assesses whether or not you have met the NELP Standard:</th>
</tr>
</thead>
</table>
(Element 2.2) Program completers understand and demonstrate the capability to model ethical behavior in their personal conduct, relationships with others, decision-making, and stewardship of the district’s resources.
(Element 2.3) Program completers understand and demonstrate the capability to ensure that unethical and unprofessional actions are addressed promptly and appropriately throughout the organization.
(Element 7.4) Program completers understand and demonstrate the capability to appropriately respond to local, state, and national decisions.
(Element 7.5) Program completers understand and demonstrate the capability to advocate for the needs and priorities of the district.

<table>
<thead>
<tr>
<th>Category</th>
<th>10 points</th>
<th>5 points</th>
<th>Zero points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Response</td>
<td>Discussion posting displays an excellent understanding of the lessons within the simulations and underlying concepts. Response is 200 words or more. Answers questions based on the following NELP Elements: (Element 2.2) Program completers understand and demonstrate the capability to model ethical behavior in their personal conduct, relationships with others, decision-making, and stewardship of the district’s resources.</td>
<td>Response is less than 200 words. The response is not based on the NELP Elements 2.2 and 2.3.</td>
<td>Partial evidence of recognition of the concepts presented. Presents no response or shows no convincing evidence that resources have been used.</td>
</tr>
</tbody>
</table>

VI. Course Assignments - If your assignment is late you will receive a zero for that assignment. You have 48 hours to earn up to half of the points back for the assignment. If it is longer than 48 hours from the due date you may earn up to ¼ of the original points.

1. **15 module discussions (600 pts)** will require you to first experience an online interactive educational simulation, and then craft a response to the discussion question(s) with a minimum of one citation. Your initial posts must be completed by 11:59 p.m. of the due date. After you submit your initial post you will be able to see the posts of your peers (unless you are the first to post in your group). You are required to respond to two of your colleagues’ comments prior to 11:59 p.m. of the deadline provided. Your response should demonstrate reflective analytical thinking and be supported with evidence from your reading.
<table>
<thead>
<tr>
<th>Category</th>
<th>10 points</th>
<th>5 points</th>
<th>Zero points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responses to Others</td>
<td>Shows definite insights into the relationship between concepts presented, class activities, and others' responses. Provides responses for two or more different threads. Response is 100 words or more.</td>
<td>Shows some insights into the relationship between concepts presented, class activities, and others' responses.</td>
<td>No evidence of the relationship between concepts presented, class activities, and others' responses. Provides response for only one thread.</td>
</tr>
</tbody>
</table>

2. **Policy Brief (400 points)** = The end goal of this assignment is to prepare a policy brief that is 3,000 - 4,000 words long (approximately 8 pages) using the submission guidelines from the National Council of Professors in Educational Administration (NCPEA) Education Policy Brief section. All information can be found at: [http://www.ncpeapublications.org/index.php/123-education-policy-brief](http://www.ncpeapublications.org/index.php/123-education-policy-brief). This assignment is designed to assist you in understanding and demonstrating your capability to appropriately respond to state or national decisions. This is not designed to review a district policy. There are eight steps below with deadlines.

   a. The purpose of the ELRC/NCPEA Education Policy Briefs is to help policymakers in advancing their knowledge and understanding of a variety of policies in
learning through a focus of high-quality briefs. The briefs may be about existing
policies or may inform new policy based on research.
b. The Education Policy Brief must be concise as the name implies. Policymakers
and their staff want the essence of the supporting research and the main points
in terms of the policy recommendations of a policy in question. The Education
Policy Brief must be coherent, easily read and understood, informative, and
research based in order for the policy makers to quickly digest it and take away
the cogent points.
c. The Education Policy Brief will be evaluated based on the following:
   i. Is there a persuasive argument?
   ii. Is the Brief clear and organized?
   iii. Does it present cogent arguments from current research in a concise and
       understandable manner?
   iv. Is there a brief overview of the issue being presented?
   v. Does the author provide an advance organizer in terms of outlining the
      matter and what the reader is about the read?
   vi. Does the author provide a brief background to the policy topic?
   vii. Does the author clearly present opinions, principles, and evidence of the
        topic?
   viii. Are recommendations stated clearly in the Brief?
   ix. Does the author close with a convincing opinion and overarching
       recommendation and a concise statement?
d. APA Publication Manual (6th Edition) must be followed, no more than 3000 to
   4000 words, and use bullets or numbered lists when possible.
e. The following are the steps to completing this assignment. I totally understand
   that this type of assignment is likely brand new, so we will take this slow.
   However, it is important that submit your work in progress during each deadline.
   i. **Step 1 = Planning Your Policy Brief and Creating a Brief Outline**
      - Become familiar with policy briefs
        a. Read multiple perspectives of what constitutes a policy brief. These multiple perspectives are uploaded to the
           "content" section of our course.
        b. Read an example of a policy brief, which is uploaded to the
           "content" section of our course.
        c. Write a short paragraph about what you learned and submit it to DropBox.
        d. Your second paragraph should include a brief explanation of what concerns you most about writing a policy brief as
           well as any questions that you may have for me.
      - Remember that a policy brief is…
        a. A short document that presents the findings and
           recommendations of a research project to a
           non-specialized audience
        b. A medium for exploring an issue and distilling lessons
           learned from the research
        c. A vehicle for providing policy advice
        d. A stand alone document
        e. Focused on a single topic
f. Between 3,000 - 4,000 words long (which is approximately eight pages long)

- When you choose a topic you will want to begin by choosing a single topic of interest to you. If you choose to give your opinion on a state policy, this is acceptable. If you choose to give your opinion on a piece of federal legislation, this is acceptable. If you choose to write about something (ideas include but are not limited to special education or transgender or salary increases for teachers or absenteeism, etc.) that should be a policy, this is acceptable. For example, the state of Iowa requires all schools in Iowa to take the Iowa Assessments (formerly the Iowa Tests of Basic Skills). Remember, this is a “Policy Brief.”

- Your audience is educational leaders and any stakeholder group of your choice (policymakers, professors, teachers, parents, students. etc.).

- Your policy brief outline should include five sections and a reference page
  a. Executive Summary
  b. Introduction
  c. Approach and Results
  d. Conclusion
  e. Implications and Recommendations
     i. You should also begin a reference page. Your policy brief must have five to ten references. This is the week that you should find your resources and add them to your policy brief. It will be much easier to

ii. Step 2 = Write the Introduction

- Answers the question why
- Explains the significance/urgency of the issue
- Describes the research objective
- Gives overview of findings, conclusions
- Creates curiosity for the rest of the brief

iii. Step 3 = Write the Approach and Results

- Your first step is to download the Microsoft Word document from the DropBox section of our course. You will see that I have turned on the track changes feature in Microsoft Word and have made specific edits to your grammar and your APA formatting. I may insert one or more comments as well. Your first step is to click on the “Review” tab in Microsoft Word and accept each change that I made one at a time. Your second step is to click on “Accept All Changes.” Your third step is to click on “Tools” and then “Track Changes” and then “Highlight Changes.” You want to make sure all checkboxes are clicked. Then you may begin working on your next step. If you fail to do any of these steps, you will automatically earn 0 points.

- Provides summary of the facts
- Describes issue and context
- Describes research and analysis
- Should not be overly technical
- Highlights benefits, opportunities
- Explains how study was conducted
- Relates who conducted study
- Describes relevant background
- Identifies method used to collect data
  a. Example: Overall it was found that although the electric fencing does help, it is not capable of completely eliminating conflict. In each area, technical as well as socio-economic factors affect success. Technical failures mainly affected the early fences. Other problems resulted from failure to take into account elephant behavior and distribution patterns.

iv. Step 4 = Write the Conclusions
- Your first step is to download the Microsoft Word document from the DropBox section of our course. You will see that I have turned on the track changes feature in Microsoft Word and have made specific edits to your grammar and your APA formatting. I may insert one or more comments as well. Your first step is to click on the “Review” tab in Microsoft Word and accept each change that I made one at a time. Your second step is to click on “Accept All Changes.” Your third step is to click on “Tools” and then “Track Changes” and then “Highlight Changes.” You want to make sure all checkboxes are clicked. Then you may begin working on your next step. If you fail to do any of these steps, you will automatically earn 0 points.
- Use this section to interpret any data
- Aim for concrete solutions
- Express ideas using strong assertions
- Ensure ideas are balanced and defensible
  a. Example: Overall, it was found that although electric fencing does help mitigate human elephant conflict, it is not capable of completely eliminating the conflict. A social factor that affected the success of electric fences was whether the local community supported the project in their area. Community support was critical in several ways.

v. Step 5 = Write the Implications and Recommendations
- Your first step is to download the Microsoft Word document from the DropBox section of our course. You will see that I have turned on the track changes feature in Microsoft Word and have made specific edits to your grammar and your APA formatting. I may insert one or more comments as well. Your first step is to click on the “Review” tab in Microsoft Word and accept each change that I made one at a time. Your second step is to click on “Accept All Changes.” Your third step is to click on “Tools” and then “Track Changes” and then “Highlight Changes.” You want to make sure all checkboxes are clicked. Then you may begin working on your
next step. If you fail to do any of these steps, you will automatically earn 0 points.

- Implications and Recommendations
  a. Implications are what could happen
  b. Recommendations are what should happen (include precise steps if possible)
  c. Both flow from what you wrote in the conclusion
  d. Both must be supported by data
    i. A successful strategy to deal with the elephant problem must be much more far-reaching than it is at present. Such a strategy should include a comprehensive land use planning exercise where elephants habitats are grouped and interconnected. The elephant’s habitat should then be enriched and fenced.

vi. Step 6 = Write the Executive Summary
- Your first step is to download the Microsoft Word document from the DropBox section of our course. You will see that I have turned on the track changes feature in Microsoft Word and have made specific edits to your grammar and your APA formatting. I may insert one or more comments as well. Your first step is to click on the “Review” tab in Microsoft Word and accept each change that I made one at a time. Your second step is to click on “Accept All Changes.” Your third step is to click on “Tools” and then “Track Changes” and then “Highlight Changes.” You want to make sure all checkboxes are clicked. Then you may begin working on your next step. If you fail to do any of these steps, you will automatically earn 0 points.
- Your executive summary should include the purpose of your policy review and describe the urgency of the situation.
- Your first statement is very important and will:
  a. Distil the essence of the policy brief
  b. Provide an overview for busy readers
  c. Entice readers to go further
  d. Appear as the first sentence
  e. Likely be revised over and over until the project is completed
    i. Example: Elephants are one of the big five wildlife species; their survival is one of the holy grails of conservation. Unfortunately, because of their size and migratory behavior, elephants often come in contact with people. This is especially true in densely populated southeast Asia. A new study from Sri Lanka looks at one strategy to address this problem - electric fences.

vii. Step 7 = Peer Review Process
- During this step, you will have an opportunity to experience the peer review process. The peer review process provides an
opportunity to learn from one another on different levels. First, reading papers from classmates provides valuable opportunities to learn about current issues and about relevant research from a fellow classmate’s perspective. Second, it allows scholar-practitioners (you) the benefit from having feedback from multiple reviewers.

- **Your first step is to download the Microsoft Word document from the DropBox section of our course.** You will see that I have turned on the track changes feature in Microsoft Word and have made specific edits to your grammar and your APA formatting. I may insert one or more comments as well. Your first step is to click on the “Review” tab in Microsoft Word and accept each change that I made one at a time. Your second step is to click on “Accept All Changes.” Your third step is to click on “Tools” and then “Track Changes” and then “Highlight Changes.” You want to make sure all checkboxes are clicked. Then you may begin working on your next step. If you fail to do any of these steps, you will automatically earn 0 points.

- Please clean up your Policy Brief to the point where you feel comfortable having your peers read your work and provide you with feedback.

b. **Your next step is to email me your Policy Brief by Sunday, April 8 at 11:59 p.m.** Before you email me your Policy Brief, please remove any identifying information so the readers of your Policy Brief will not know that you are the author.

- **For the Peer Review, you will be assigned two Policy Briefs to review and to provide constructive feedback.** Each review is worth 25 points for a total of 50 points for fully participating in the process.

  a. **Feedback Format.** You are to use *Track Changes* in Word. The following are the directions.

   i. **Track Changes:** The document must be a Word Document, with the Word document open, go to the Review tab. There you will see “New Comment” as one of the many icons displayed across the top menu. When you are ready to comment on a peer's paper, place cursor where you intend the comment to be located and click on the “New Comment” icon. A small box will appear and you will be able to click inside the box and type in your comment. You may do this as often as you want throughout the paper to provide detailed feedback for your peer.

   ii. **Note,** each comment includes your name (if you are on your own device). To keep the feedback anonymous, remove your name from the New
Comment boxes. This can be done by taking the following steps:

iii. Remove Your Name: With the Word document open, click the File tab on menu (top left). Make sure “Info” is selected at the left side of the screen. (It should be selected by default.) Click the “Check for Issues” button (right next to the wording “Prepare for Sharing.”)

iv. Word displays a few options you may choose. Click “Inspect Document.” Word displays the Document Inspector dialog box. Make sure all the available checkboxes are selected. Click “Inspect.” Word examines your document for identifying information and displays, in a dialog box, what it finds. Use the controls in the dialog box to get rid of any “identifying information,” i.e., your name. Click the Close button when done.

v. However, you are not done. When you are through running the Document Inspector, and assuming you removed personal identification, save the document and at that time of saving, Word replaces your name with the word “Author.”

vi. MAC users: With the document open, go to the Review tab and click the Protect Document button (or go to Tools>Protect Document). The check box for Remove Personal Information from this File on Save is at the very bottom.

b. In addition to using Track Changes to provide feedback to classmates, provide comments to the following questions. Answers to the questions will be provided to the author.

i. Does the paper provide a clear description of the policy?

ii. Does the paper include information from outside sources, (i.e. journal articles) that are clearly related to the issue?

iii. Has the relevance of the outside sources to the policy been explained clearly in the paper?

iv. Has the author cited sources and used APA formatting correctly?

v. Is the paper written in a way that the policy is addressed in a logical order?
   1. Executive Summary
   2. Introduction
   3. Approach and Results
   4. Conclusion
   5. Implications and Recommendations
vi. Please come up with three “I wonder...” statements. Basically, this is a professional way to provide constructive feedback to your peers. Each of your three sentences should begin with “I wonder...”

   c. Please return feedback to me via DropBox. I will deliver the feedback to the authors via D2L email. Authors will then be able to use the feedback to improve their Policy Brief.

viii. Step 8 = Check Your Work

   ● Your first step is to download the Microsoft Word document from the DropBox section of our course. You will see that I have turned on the track changes feature in Microsoft Word and have made specific edits to your grammar and your APA formatting. I may insert one or more comments as well. Your first step is to click on the “Review” tab in Microsoft Word and accept each change that I made one at a time. Your second step is to click on “Accept All Changes.” Your third step is to click on “Tools” and then “Track Changes” and then “Highlight Changes.” You want to make sure all checkboxes are clicked. Then you may begin working on your next step. If you fail to do any of these steps, you will automatically earn 0 points.

   ● Is your policy brief between 3,000 - 4,000 words?

   ● We wait to write the Executive Summary until the end, but you should put your Executive Summary before your Introduction when you organize your paper. Please move the Executive Summary to the appropriate place.

   ● You will want to tweak your work to answer the following questions:

      a. Is there a persuasive argument?
      b. Is the policy brief clear and organized?
      c. Does it present cogent arguments from current research in a concise and understandable manner?
      d. Is there a brief overview of the issue being presented?
      e. Does the author provide an advance organizer in terms of outlining the matter and what the reader is about the read?
      f. Does the author provide a brief background to the policy topic?
      g. Does the author clearly present opinions, principles, and evidence of the topic?
      h. Are recommendations stated clearly in the policy brief?
      i. Does the author close with a convincing opinion and overarching recommendation and a concise statement?

   ● Please download the free version of Grammarly from https://www.grammarly.com/. There are multiple options on how to use Grammarly, but the easiest is to download the free version as an application to your computer desktop. Then you can drag your finished product into the Grammarly program, and it will likely offer many suggested changes that will improve your final product.
Most of our Ed. D. students working on a dissertation use Grammarly the same way.

**Feedback and Turn Around Time** - I will respond to your emails within 24 hours during the week. I will have limited opportunities to reply to emails over the weekend, so please call or text me at (641) 629-0200 if you need immediate assistance. You will receive feedback on any papers, discussion questions or other written assignments within one week following the due dates.

**Assignment Due Dates** - Due dates can be found in the section below. Assignments will be corrected in one week and feedback will be sent to you through the Dropbox. The expectation of this course is that each student will complete the work associated with the course at the times noted in the syllabus. Should a student find that getting the assignment in on time would not be possible due to circumstances beyond his/her control, please contact me to make an alternative arrangement.

**Grading**: I begin grading assignments as soon as possible after the due dates.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Point Value</th>
<th>Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Discussion Posts</td>
<td>600 points (40 points for each of the 15 modules)</td>
<td>Initial posts which require you to search for a research article are due by 11:59 p.m. of the dates provided on the discuss section. Responses to two peers are due by 11:59 p.m. of the dates provided on the discuss section.</td>
</tr>
<tr>
<td>Policy Brief</td>
<td>400 points (50 points for each step)</td>
<td>We will break this assignment into eight separate steps, and each step lasts two weeks and is due at 11:59 p.m.</td>
</tr>
</tbody>
</table>

1) Step 1 is due January 21  
2) Step 2 is due February 4  
3) Step 3 is due February 18  
4) Step 4 is due March 4  
5) Step 5 is due March 18  
6) Step 6 is due April 1  
7) Step 7 is due April 15  
8) Step 8 is due April 29

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Point Value</th>
<th>Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOTAL</td>
<td>1,000 points</td>
<td></td>
</tr>
</tbody>
</table>

**Grading Scale:**

<table>
<thead>
<tr>
<th>Points</th>
<th>Percentage</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>935 - 1000</td>
<td>94-100%</td>
<td>A</td>
</tr>
<tr>
<td>835 – 934</td>
<td>84-93%</td>
<td>B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>735 – 834</td>
<td>74-83%</td>
<td>C</td>
</tr>
<tr>
<td>635 – 734</td>
<td>64-73%</td>
<td>D</td>
</tr>
</tbody>
</table>

Written work will be graded for being submitted on time, grammatical correctness, clarity of thought, evidence of analysis, depth of understanding, and evidence of reflective thinking.

**VII. Academic Misconduct** - The University of South Dakota considers plagiarism, cheating, and other forms of academic dishonesty iminical to the objectives of higher education. The University supports the imposition of penalties on students who have been adjudicated to have engaged in academic dishonesty, as defined in the “Conduct” section of the University of South Dakota Student Handbook, and South Dakota Board of Regents policy 2-33 [www.sdboar.edu/policy/Documents/2-33.pdf](http://www.sdboar.edu/policy/Documents/2-33.pdf).

No credit can be given for a dishonest assignment. A student found to have engaged in any form of academic dishonesty may, at the discretion of the instructor, be:

a. Given a zero for that assignment.

b. Allowed to rewrite and resubmit the assignment for credit.

c. Assigned a reduced grade for the course.

d. Dropped from the course.

e. Failed in the course.

As stated in the Student Code of Conduct, the integrity of the University community is contingent upon fulfillment of a trust—that the members of the student body will engage in reasonable behaviors to promote and protect the educational environment. Plagiarism, is defined as, but not limited to, the following: the use of paraphrasing or direct quotation of published or unpublished work of another person without full and clear acknowledgement and the unacknowledged use of materials prepared by another person or agency engaged in the selling of term papers or other academic materials. A student found to have engaged in an act of academic dishonesty is subject to the processes detailed on the portal. Refer to the Student Handbook for consequences of academic dishonesty: [http://www.usd.edu/studentserv/handbooks/studenthandbook.pdf](http://www.usd.edu/studentserv/handbooks/studenthandbook.pdf).

**VIII. Freedom in Learning** - Under Board of Regents and University policy student academic performance may be evaluated solely on an academic basis, not on opinions or conduct in matters unrelated to academic standards. Students should be free to take reasoned exception to the data or views offered in any course of study and to reserve judgment about matters of opinion, but they are responsible for learning the content of any course of study for which they are enrolled. Students who believe that an academic evaluation reflects prejudiced or capricious consideration of student opinions or conduct unrelated to academic standards should contact the School of Education at (605) 677-5437 to initiate a review of the evaluation.

**IX. Diversity and Inclusive Excellence** - The University of South Dakota strives to foster a globally inclusive learning environment where opportunities are provided for diversity to be recognized and respected. To learn more about USD’s diversity and inclusiveness initiatives, please visit the website at [http://www.usd.edu/diversity-and-inclusiveness](http://www.usd.edu/diversity-and-inclusiveness).
X. Disability Services - Any student who feels he or she may need academic accommodations or access accommodations based on the impact of a documented disability should contact and registrar with Disability Services during the first week of class. Disability Services is the official office to assist students through the process of disability verification and coordination of appropriate and reasonable accommodations. Students currently registered with Disability Services must obtain a new accommodation memo each semester.

For information contact:

Ernetta L. Fox, Director
Disability Services
Room 119 Service Center
(605) 677-6389
www.usd.edu/ds; dservices@usd.edu